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1. Access & registration

la. Registering with EndNote Online

e System and browser requirements: if you are using your own device to
access EndNote Online, check that your system and browser are
compatible:
http://www.myendnoteweb.com/help/ENW/hgs requirements.htm

e Go to the Library webpage, ‘Social & Policy Sciences: Search the
Literature’: https://library.bath.ac.uk/social-policy-sciences/literature-

search - then connect to the database, Web of Science (listed under
‘Search for journal articles’).

If you are registering from an off-campus location, you need to connect to
the library webpage using a UniDesk connection. Instructions for setting
up: http://www.bath.ac.uk/guides/working-from-any-location-with-your-



http://www.myendnoteweb.com/help/ENW/hgs_requirements.htm
https://library.bath.ac.uk/social-policy-sciences/literature-search
https://library.bath.ac.uk/social-policy-sciences/literature-search
http://www.bath.ac.uk/guides/working-from-any-location-with-your-own-device/

own-device/

Once you have entered Web of Science, click ‘sign-in” and then ‘register’
(top of screen). Enter your University of Bath email address twice. Don’t
enter any other email address, and don’t register via either Facebook or
LinkedlIn, as this can cause problems e.g. no access to Harvard (Bath).
Click ‘continue’.

Help » English »

=] Signln _
L (3 Clarivate
[# Register Analytics

[ LogOut
Tools + Searches andE—_ B

story  Marked List

As part of the registration process, an email is sent to your University of
Bath account — the email will contain a code that you will need to paste

into your registration box. You may find the email in your junk folder or
‘other’ folder (rather than ‘focused’ folder in Outlook).

When completing the registration form, follow the exact requirements
for creating your password e.g. only select symbols from the list provided.

1b.  Accessing EndNote Online

Access EndNote Online by visiting ‘Social & Policy Sciences: Search the
Literature’: https://library.bath.ac.uk/social-policy-sciences/literature-

search - then connect to the database, Web of Science (listed under
‘Search for journal articles’).

Ensuring continued access throughout your studies: if you connect to
EndNote Online directly via Google, rather than Web of Science, you may
find that after 12 months, you only have access to “EndNote Basic” which
offers less functionality (e.g. fewer referencing style options and a limit of
50,000 references).

After you have completed your studies at the University of Bath: you
retain access to the full version of EndNote online until 12 months have
passed (at which point, you will be able to access ‘EndNote Basic’ which
stores up to 50,000 of your references).


http://www.bath.ac.uk/guides/working-from-any-location-with-your-own-device/
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2a.

Collecting and organising references
in EndNote Online

Transferring results from Scopus into EndNote Online

Access EndNote Online: refer to 1b for important instructions. Keep
EndNote Online open in one tab/window.

In another tab/window, go to the Library webpage, ‘Social & Policy Sciences:
Search the Literature’: https://library.bath.ac.uk/social-policy-

sciences/literature-search - then connect to the database, Scopus (listed

under ‘Search for journal articles’).

When entering search terms, note that the word, or, is entered in between
alternative search terms. Also, search terms are organised by “sub-theme”
i.e. search terms related to each “sub-theme” are entered in separate search
box. Click ‘+ Add search box’ as relevant. Click Search.

Note: you can re-sort your results by relevance (options appear to the right
above your search results). Click ‘Links’ to check a document’s availability.

Document search
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v
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roeclibaral™ ar nea-liberal™ ¥ Article tithe, Abstract, Keywards H El

Search Oy

Select a few references from your results to transfer (tick the relevant boxes
to the left). Click the export option above the results.
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All Export Download  View citation overview  View cited by  Add to List = wee = =

Export the selected documents

Document title Authors Year Source

1 Territorial and agrarian rights: land mobility and ~ Diego 2001 Toplum ve bilim
land market after 18 years of neoliberal politics Quintana, R., (88), pp. 122-143
in Mexico. | [Bolgesel ve tarimsal haklar: Concheiro
meksika'da 18 yillik neo-liberal politikalar sonrasi  Borquez, L.,
toprak hareketliligi ve toprak pazari] Tarrio Garcia,

M., Golbasi, S.
“
@ links
m > Introduction: Emerging challenges, new policy Almis, R., 2012 Research in Rural Sociology and

frameworks and the resilience of agriculture Campbell, H. Development

View abstract ~ “ links Related documents

| 3| The urgency and necessity of a different type of ~ VanderHoff 2009
market: The perspective of producers organized  Boersma, F.
within the fair trade market

18, pp. 1-22

Journal of Business Ethics
86(SUPPL. 1), pp. 51-61

iii. Adialog box will appear. Select ‘RIS format’ and then click ‘Export’.

Export document settings @
You have chosen to export 2 documents

Select your method of export

MM MENDELEY I Ref i Scival @ RIS Format (EndNote, Reference Manager) CSV (Excel)
What information do you want to export?

Customize export

BibTeX Text (ASCIl in HTML)

W Citation information Bibliographical information Abstract and Keywords Funding Details Other information
B Author(s) Affiliations Abstract Number Tradenames and Manufacturers
B Document title Serial identifiers (e.g. ISSN) Author Keywords Acronym Accession numbers and Chemicals
H Year PubMed 1D Index Keywords Sponsor Conference information
B Source title Publisher Funding text Include references
B Volume, Issue, Pages Editor(s)
B Citation count Language of Original Document
B Source and Document Type Correspondence Address
H DOl Abbreviated Source Title
Cance

Note: how the references are saved will depend on which internet browser
you use: they may be saved as a file in a downloads folder on your device.
Alternatively, you will be provided with a ‘Save As’ option and you can then
opt to save the references as a file in a location/drive of your choice.

The ‘save as’ option may appear within a band across the bottom of your
screen (if a band appears, click the down arrow to the right of ‘save’ and then

click ‘save as’).



2b.

Viewing and organising your results in EndNote Online

Open EndNote Online (via Web of Science). Click the Collect tab followed by
Import References.

My References Collect Organize Match "= Options
Cnline Search Mew Reference Import References

Click browse to search for the saved file of references. Then, click on the
Import option menu and select Scopus (you may first need to click ‘Select
Favourites’ first, select ‘ProQuest’ and then click ‘Copy to favourites’).

Next, you have to give them a location in the To field. To do this, you could
do one of the following: select an existing ‘group’ if you’ve already set one
up, select ‘New Group’ to create one, select [unfiled]. Finally, click Import.

My References Collect Organize Format Match Options Downloads

Online Search  Mew Reference  Import References

Import References

Importing from EndMote?

File: Choosa File | Mo file chosen

Import Option: | Scopus v Select Favorites
To: | [unfiled] v

Your results should then transfer to the ‘all my references’ or ‘unfiled’ (left-
hand menu). Occasionally, you might need to refresh your screen, log out
and in again, or wait a little while for these to appear. Note: you can click the
blue & white ’Links’ icons to check for full-text availability.
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All My References
Show 50 per page ¥
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Author
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Logan, B. L.

¥ | Copy To Quick List

Year

2009

2001
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Delete
Title

The fallacies behind trade liberalisation of agricultural products: A dilemma of sub-sahara african
Creating Global Economies through Innovation and Knowledge Management Theory and Practice -
Information Management Association Conference, IBIMA 2009

Added to Library: 29 Mov 2016 Last Updated: 29 Nov 2016

Online Link= Go to URL

- & links

Neoliberalism, regime survival, and the environment: economic reform and agricultural transforma
Canadian journal of African studies

Organising your references by theme or piece of work: to do this, select/tick

those references that are related. Then, click ‘add to group’ to open a menu.

Click the ‘New group’ option and enter an easily identifiable name for the

group. Click ‘OK’. The group will appear in the left-hand menu in ‘My Groups’.

All My References
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1 Trauger, Army

2014

-

myendnoteweb.com needs some information

Script Prompt:

Enter a New Group name and click OK

Cancel

New Group]

Note: you can also select individual references that you no longer require and

then click the Delete button above. Deleted references are sent to the Trash

folder in the left-hand column. You can opt to ‘empty’ your trash but it is

advisable not to do that.

Please note: | would strongly recommend saving references from Scopus and

other databases using multiple methods (including email) as “back-ups”.



2C.

3a.

Transferring references from other databases
and Google Scholar into EndNote Online

You can find instructions for transferring references from a range of
databases/resources, including IBSS, Business Source Complete and Google
Scholar at: http://www.bath.ac.uk/library/infoskills/endnote/endnoteweb-

download.html

Please note in Business Source Complete: you can send your selected results
directly to EndNote Online via the folders option i.e. you don’t need to create
a file of references first.

Citing & referencing while you write

Displaying the EndNote toolbar and signing in:

Open Word. Click on the last tab; the name of the tool bar/tab will be
‘EndNote’ or similar.

If the EndNote tool bar/tab is not present in Word:

If you are using an on-campus PC: try another PC, join another student to
complete the exercise or contact Computing Services (include the ID
number of the PC):
https://www.bath.ac.uk/professional-services/computing-services/

If you are using your own device:

e Connect to Web of Science (via the Library website) and sign-into
EndNote Online.

e Click the ‘Downloads’ tab.

e You may need to check the instructions and system requirements.

« Click either the link to the Windows or Macintosh file to download
the tool bar. Open Word to view the tab.


http://www.bath.ac.uk/library/infoskills/endnote/endnoteweb-download.html
http://www.bath.ac.uk/library/infoskills/endnote/endnoteweb-download.html

If the tool bar is still not present in Word:

With Windows devices, try clicking File > Options > Customize Ribbon. Then
select the EndNote option in the second menu and click OK. If this does not

work, or is not available, contact the provider, Clarivate, at

https://support.clarivate.com/s/

Once the EndNote tool bar is present: click the Preferences icon on the right-

hand side of the toolbar.
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Application
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Application:
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Cancel Help

Tools

In the Preferences box, click the application tab. Select the EndNote

Online (not ‘Endnote’ option) from the menu if it’s not already displayed.

Enter your EndNote Online email and password (the one with which you

registered and signed into the service). Click OK.

EndMote
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3b. Setting the required referencing style

i. Check that the required referencing style is selected in the Style drop-
down menu in Word’s EndNote tab e.g. ‘Harvard (Bath)’. If the required
referencing style is not listed, click Select another style to find it.

ii. Ifit’s still not listed in Word’s EndNote tab, open EndNote Online (via
Web of Science). Click the Format tab and then click bibliography just
below. From the “references” options, select either “all references in my
library” or a relevant group.

My References  Collect  Organize | Format latch  Options  Downloads
Bibliography Cite While You Write™ Plug-In  Format Paper Export References
Bibliography
References: | all References in My Library ¥
Bibliographic style: | select... ¥ | Select Favorites
File format: | Select... v
Cove | cowr |

Select the required style, click copy to favorites and then select the style
from your favorites list. You may need to refresh your screen at the end.
Finally, select the ‘Format file’ type as TXT and click ‘save’. You may need
to close Word and reopen it in order to see the newly added style listed —
there may be a delay before you can view it.

3c. Inserting citations

i. Type any sentence into Word. Click Insert Citations on the toolbar (the
magnifying glass on the left).

i. Enter an author surname for one of references that you transferred to
EndNote Online from Web of Science. Click Find.



foning] - Find
Koning 2001 Food insecurity, soil degradation and agricultural markets in West Africa: why current policy approaches fail
< | (1l 3
Reference Type: Journal Artice "
Author: Koning, Niek B
Heerink, Mico =
Kauffman, Sjef "‘ ‘
Year: 2001 !
Title: Food insecurity, soil degradation and agricultural markets in West Africa: why current policy approaches fail
Journak Oxford development studies
Volume: 29
Issue: 2
Pages: 189-207
ISSh: 1350-0818, 1360-0818
Notes: Date revised - 2013-05-12 7
[ mset [=||[ cancet | [ Helo |
ii. Click insert (multiple references to the same author? select the correct
one first). You should now see the author’s name and date of the paper
appear as a citation. Also, a full reference should appear at the end of
your writing.
File Home Insert Design Layout References Mailings Review View EndMaote
I,,l @ I,, l. Style: Harvard (Bath) - Exportto EndMote =
Q * I_E,l Update Citations and Bibliography -.—_._:Preferences
Insert  Go to EndMote Edit
Citations Online Citation(s) B2 Convert Citations and Bibliography = eEndNotE Help
Citations Bibliography = Tools
Navigation v X
Search Document p-
9 (oo | =
E (oo | &
This document does not
contain headings. This concept was explored further (Koning ef al 2001)
To create navigation tabs,
reate headings i your Koning, N, Heerink, N. & Kauffman, 5., 2001. Food insecurity, soil degradation and
f‘g;udmzn;ts.‘yEZFply'ng agricultural markets in West Aftica: why current policy approaches fail. Oxford
development studies, 29(2), pp. 189-207.
|

iv. Type some further text. Then, repeat steps ii-iv above (but search for a
different author’s name). Note that a list of references will start to
emerge —and in the alphabetical order by author surname.
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V.

The concept was explored further (Koning et al. 2001) and research was undertaken
bv Bowver (2010)

Boyer, I.. 2010. Food security, food sovereignty, and local challenges for
transnational agrarian movements: the Honduras case. Jowrnal of peasant studies,
37(2), pp. 319-351.

Koning, N_, Heerink, N. & Kauffman, 5., 2001. Food insecurity, soil degradation and
agricultural markets in West Africa: why current policy approaches fail. Oxford
development studies, 29(2), pp. 189-207.

Excluding the author from brackets: note the options available via the
Insert drop-down menu.

It is possible to insert the full reference but exclude the author or year
from the in-text citation so that you can enter these manually. This
would enable you to vary the ways in which your citations appear.

4. Manually amending a citation or reference

4a. Adding page numbers to a citation

Do not manually add the page numbers into your Word document.
Instead, highlight the citation in your Word document and click the ‘Edit
Citation(s)’ button within your EndNote toolbar.

Enter the page number(s) in the pages field (do not enter “p” or “pp”).
Then, click OK.

If this does not work, instead try entering the following in the suffix field.

Leave a space and then enter the page(s). For example, enter p.4 or pp.4-
5 (do not add a full stop). Then, click OK.
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4b.  Removing authors from brackets in a citation

e Do not manually delete the authors in your Word document. Instead,
highlight the relevant citation and click the ‘edit citation(s)’ button within
your EndNote toolbar.

File Home Insert D =sign Layout References Mailings Review View EndMate O Tell me what you want to de...

Style: Harvard (Bath) - ExporttDEndNote'
R o

E‘ Update Citations and Bibliography :—E Preferences
Insert  Goto EndNgpe  Edit
Citations ~ Online | Citation(s) [ Convert Citations and Bibliography - ﬂEndNote Help

Navigation v X
Search Document B~
1%[8

This document does not

contain headings. Coordination has been proven to be a vital factor in creating t
el veooty DRV ARGREND

To create navigation tabs,
create headings in your
document by applying
Heading Styles.

e Adialog box will appear. In the ‘edit citations’ section of the box, click
‘exclude author’. Then, click OK. You can now manually enter the author
surname(s) manually outside of the brackets and the full reference should

still include the author surname(s).

pre

Citation Count Library
{De Witt & Hinrichs, 2012)

De wWitt, 2012, Mechanic... 1 Trawveling Library Edit Reference | w

Edit Citation | Reference |

Exclude author [C] Exclude year

Prefix:
Suffix:

Pages:

[ Ok J [ Cancel ] [ Help
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4c.

4d.

4e.

Creating a secondary citation (author 1 cited by author 2)

Highlight the relevant citation and click the ‘edit citation(s)’ button within
your EndNote toolbar. A dialog box will appear. In the ‘edit citations’ section
of the box, enter the following in the prefix field: the surname of the author
who cited the original source, a comma, a space, the year of the
corresponding publication and a final space.

Then, in the suffix field, add a comma followed by a blank space and the page
numbers (don’t enter these in the pages field!). For example:, pp.17-18.

Amending a reference

Check that EndNote has imported all your references as they need to appear
(just selecting the correct referencing style might not be sufficient). Ifa
reference is incorrect, don’t try to amend it in Word. Instead, save your
document and keep it open. Then, connect to EndNote Online, go to ‘my
references’ and click on the relevant reference. Finally, click each piece of
information that needs editing, make your amendments. For example:

Referencing a specific chapter in an edited book: ensure the ‘reference
type’ at the top of reference page is set to ‘book section’ (not ‘book’).
Check that details for both author(s) and editor(s) are included. Enter the
chapter title and page numbers in the relevant fields. Click ‘save’.

Referencing institutional authors: you may need to add a comma at the
end of the institution’s name, in EndNote Online so that it appears
correctly in Word. The comma won’t appear in Word. Click ‘save’.

e After making your amendments in EndNote Online: re-import the
reference into your document. In Word, highlight the relevant citation.
Click ‘Edit Citation(s)’ within the EndNote toolbar. Then click ‘edit
reference’ and ‘update from My Library’. Finally, click ‘insert’ and ‘OK’.

Amending the space between references in your reference list

If your departmental guidelines require you to amend/add these spaces, click
the small arrow to the right of the single word, ‘bibliography’ in Word’s
EndNote toolbar. Click the ‘layout’ tab in the resulting dialog box, select the
amount of space required from the ‘line spacing’ options. Click ‘OK’.
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5. Manually creating a reference

If you are not able to transfer a reference into EndNote Online, you will need
to create the entire reference manually within EndNote Online. To do this:
connect to EndNote Online. Then, click on the ‘collect’ tab followed by
‘new reference’ located just below. Select the relevant reference type.

EndNote™

My References

Quick Search
Search for
in| all My References

Search

Hide panel

My References
All My References (387)
[Unfiled] (48)
Quick List (0)
Trash (399) Empty
¥ My Groups
acculturation (37)
acl (4)
biomechanics (2)
ethics (2)
food security (7)

Collect Organize

Format

Match Options Downloads

Online Search  Mew Reference Import References

New Reference

Bibliographic
Fields:

Reference Type:
Author:

Title:

Year:

Secondary Author:
Secondary Title:

Place Published:

Cancel

Generic

Aggregated Database
Ancient Text

Artwork

Audiovisual Material
eill

Elog

Book

Book Section

Case
Catalog
Chart o

ch

Computer Program
Conference Paper

e Within each relevant field of the reference: add the information that you
need for the reference. Finally, click ‘save’. Then insert the reference
into Word (you may need to log out of EndNote Online and Word first).

¢ Annotating reference: you can annotate references (e.g. to summarise or
reflect upon the content of a paper). To do this: click on a reference’s
‘research notes’ field further down the screen, enter your text and save

the changes to your reference

6. Submitting assignments: reference issues

Moodle has a tool that lecturers can use to convert assignments into a format that
so that they can be annotated. This tool does not properly convert references that
have been created in Word through EndNote (or via other tools e.g. Mendeley and
Word’s own citation tool). The Library has been advised that one workaround that
might be permitted is for you to convert your assignments from Word documents to
PDFs before submitting them to Moodle. However, please confirm the situation
with your department first and if a PDF conversion is not permitted, please contact
the Library for details of an alternative option to try: library@bath.ac.uk

7. Further support: https://library.bath.ac.uk/referencing/endnote-online

Peter Bradley; University of Bath: 03/03/2021
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First name. Enter each name on a new line.
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